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1 To περιβάλλον εργασίας του Origin

To πρόγραμμα Origin αποτελεί ένα ολοκληρωμένο πακέτο γραφικής αναπαράστασης και ανάλυσης

δεδομένων. Είναι γρήγορο, με πολλές δυνατότητες, εύκολο στη χρήση και αποτελεί ιδανική λύση για όλες

τις επιστήμες που απαιτούν γραφικές παραστάσεις, διαχείριση δεδομένων και ανάλυση αποτελεσμάτων.

Το πρόγραμμα OriginPro παρέχει σε γραφικό περιβάλλον, δυνατότητες απευθείας εισαγωγής δεδομένων

ή εισαγωγή από εξωτερικά αρχεία δεδομένων, δημιουργίας επαγγελματικών γραφικών και εξαγωγής

τους σε πλήθος διαφορετικών μορφοποιήσεων.
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1 To περιβάλλον εργασίας του Origin

Η εκτέλεση του προγράμματος

γίνεται από το σχετικό μενού ή

το σχετικό εικονίδιο, ενώ η

αρχική του οθόνη φαίνεται

παρακάτω. Το Origin αυτόματα

ανοίγει ένα δίστηλο φύλλο για

εισαγωγή δεδομένων (Data1),

ενώ στο κάτω μέρος της οθόνης

φαίνονται άλλα δύο παράθυρα

o Διαχειριστής Εργασιών:

Project Explorer (αριστερά) και

η Καταγραφή Αποτελεσμάτων:

Results Log (δεξιά).
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1 To περιβάλλον εργασίας του Origin

Tο πρόγραμμα Origin αποθηκεύει τα αρχεία του σε μορφή εργασιών (project) με τύπο opj. Ένα τέτοιο

αρχείο μπορεί να περιλαμβάνει διαφορετικά επιμέρους παράθυρα, που κάποια από αυτά είναι φύλλα

δεδομένων, άλλα είναι γραφικές παραστάσεις και άλλα διαδικασίες υπολογισμού. Η πλήρης διαδρομή

μαζί με το όνομα του αρχείου αυτού εμφανίζεται στην κορυφή του παραθύρου του προγράμματος

Origin.
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1 To περιβάλλον εργασίας του Origin

Ο Διαχειριστής εργασιών (Project Explorer) δείχνει τη δομή ενός τέτοιου αρχείου, που μπορεί ο χρήστης να

διαμορφώσει τα δεδομένα του σε υποκαταλόγους, τα οποία δεδομένα υπάρχουν ενσωματωμένα στο ενιαίο

αρχείο τύπου opj.
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1 To περιβάλλον εργασίας του Origin

Σε περίπτωση που ολοκληρώσαμε την εργασία μας μπορούμε να την αποθηκεύσουμε σαν αρχείο

του Origin (*.opj) που περιέχει όλα τα φύλλα εργασίας αλλά και όλες τις γραφικές παραστάσεις σε

ένα μόνο αρχείο μέσα από τις επιλογές Save Project και Exit από το μενού File.

Επίσης μπορείτε να αποθηκεύσετε μεμονωμένες γραφικές παραστάσεις ή φύλλα εργασίας από την

επιλογή File - Save Window As και να τα συμπεριλάβετε στη συνέχεια σε άλλες εργασίες.

Για να ανοίξουμε μια εργασία του Origin (Project) File > Open ή επιλέγοντας το εικονίδιο Open. 

Άνοιγμα-Αποθήκευση Αρχείων

Είναι μια καλή πρακτική να σώζουμε σε τακτά χρονικά διαστήματα ενώ εργαζόμαστε.

Για να ενσωματώσουμε πολλά διαφορετικά αρχεία του Origin σε ένα αρχείο: Ανοίγω ένα από τα διαφορετικά

αρχεία και μετά με την επιλογή File > Append ενσωματώνοντας ένα-ένα και τα υπόλοιπα επιλέγοντας να

βρίσκονται στο ίδιο «εσωτερικό» κατάλογο του project ή σε διαφορετικούς υποκαταλόγους
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2 Εισαγωγή δεδομένων

Το Origin με την εκκίνησή του, δημιουργεί μια κενή εργασία (project)

που περιέχει ένα κενό φύλλο δεδομένων (workbook) με δύο στήλες. Η

πρώτη στήλη ονομάζεται Α(Χ) και η δεύτερη Β(Υ), που σημαίνει ότι η

πρώτη στήλη είναι τα δεδομένα για τον άξονα Χ, ενώ η δεύτερη και

όλες οι επόμενες τα δεδομένα για τον άξονα Υ.

H πρώτη εργασία, μετά την έναρξη

του προγράμματος Origin, είναι η

εισαγωγή δεδομένων είτε από

κάποιο υπάρχον αρχείο δεδομένων,

είτε πληκτρολογώντας τα δεδομένα

στα κελιά που εμφανίζει το δίστηλο

φύλλο εργασίας του Origin.

 New Project Νέα εργασία 

 New Folder Νέος φάκελος  

 New Workbook Νέο φύλλο δεδομένων  

 New Excel Φύλλο Excel  

 New Graph Νέα γραφική παράσταση  

 New Matrix Νέος πίνακας υπολογισμών  

 New Function Νέα συνάρτηση  

 New Layout Νέα αναφορά  

 New Notes Νέα σημείωση  
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2 Εισαγωγή δεδομένων

Με δεξί click πάνω στο όνομα της στήλης μπορούμε να

επιλέξουμε από το μενού που εμφανίζεται διαφορετικές

επιλογές για τη συγκεκριμένη στήλη.

Μπορούμε να αλλάξουμε τον τύπο δεδομένων της

συγκεκριμένης στήλης.

Οι επιλογές είναι Χ, Y, Z (για τρισδιάστατες γραφικές

παραστάσεις), στήλη ετικετών που μπορούν να

εμφανίζονται στη γραφική παράσταση δίπλα στα

δεδομένα ή ως όρια σφαλμάτων (X-, Y-error) που να

δείχνουν τη διακύμανση της συγκεκριμένης μέτρησης

γύρω από μια συγκεκριμένη τιμή.
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2 Εισαγωγή δεδομένων

Στο ίδιο μενού επιλογής υπάρχει

και η επιλογή Set Column Values,

με τη βοήθεια της οποίας

μπορούμε να εφαρμόσουμε

πράξεις πάνω στα δεδομένα της

συγκεκριμένης στήλης που έχει

επιλεγεί.



Data processing 
Input-Process-Output Ομάδα Β. Επεξεργασία πειραματικών δεδομένων

Εργασία Γραφικές αραστάσεις δύο διαστάσεων

|10Εργαστήριο Εφαρμοσμένης Πληροφορικής
Τμήμα Φυσικής-ΑΠΘ

Είναι συχνή η περίπτωση της σχεδίασης μιας καμπύλης από δεδομένα που υπάρχουν ήδη σε κάποιο

αρχείο δεδομένων (συνήθως τα αρχεία δεδομένων είναι τύπου ASCII).

Από την επιλογή File > New επιλέγουμε Worksheet για να ανοίξει ένα νέο φύλλο δεδομένων. Στη

συνέχεια επιλέγουμε File > Import > Simple Single ASCII, και από το πλαίσιο διαλόγου που

εμφανίζεται, επιλέγουμε το αρχείο που θέλουμε να ανοίξουμε κάνοντας Click στο όνομά του και στη

συνέχεια επιλέγουμε Open.

Τα αρχεία Excel μπορούν να ανοιχθούν από το OriginPro με την επιλογή File - Open Excel απευθείας.

Εκτός από αρχεία Excel με την επιλογή File - Import μπορούμε να εισάγουμε δεδομένα από διαφόρους

τύπους αρχείων: ΑSCII, Lotus, dBASE, DIF, Thermo Galactic, MATLAB, MiniTab, LabTech, SigmaPlot,

Sound, Mathematica, Kaleidagraph και pCLAMP.

Εναλλακτικά μπορούμε να χρησιμοποιήσουμε την ομάδα εντολών Cut/Copy/Paste

2 Εισαγωγή δεδομένων
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Μια γραφική παράσταση μπορεί να

σχηματιστεί είτε με βάση κάποια

αριθμητικά δεδομένα που

υπάρχουν σε κάποιο φύλλο

εργασίας, είτε δίνοντας το

μαθηματικό τύπο μιας συνάρτησης

(που είναι συνήθως μια αριθμητική

σχέση που υπολογίζει την

εξαρτημένη μεταβλητή Υ σε σχέση

με την ανεξάρτητη μεταβλητή X).

3 Δημιουργία γραφικής παράστασης
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Η συνήθης επιλογή επεξεργασίας του

καθενός από τα στοιχεία που

εμφανίζονται σε μια γραφική παράσταση,

γίνεται με διπλό click πάνω στο στοιχείο

και το πλαίσιο διαλόγου που ακολουθεί

περιέχει όλες τις δυνατές μορφοποιήσεις

στο συγκεκριμένο στοιχείο.

3 Δημιουργία γραφικής παράστασης

Σε ένα υπάρχον φύλλο δεδομένων, επιλέγουμε δύο στήλες δεδομένων (που έχουν τύπους X και Y

αντίστοιχα) και επιλέγοντας από το μενού Plot, την εντολή Line + Symbol βλέπουμε ένα νέο παράθυρο να

ανοίγει και να εμφανίζει τη γραφική παράσταση των δύο στηλών με τα αριθμητικά σημεία να

απεικονίζονται και να ενώνονται μεταξύ τους με μια απλή γραμμή.
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Σε περίπτωση που δεν έχουμε επιλέξει κάποια δεδομένα, από το μενού Plot και την εντολή Line + Symbol,

ανοίγει το παράθυρο διαλόγου Plot Setup, από όπου μπορούμε να επιλέξουμε τα δεδομένα που θέλουμε να

σχεδιάσουμε, όπως φαίνεται και στο σχήμα που ακολουθεί. Στο παράθυρο αυτό εμφανίζονται όλοι οι τύποι

γραφικών παραστάσεων του προγράμματος Origin, και επιλέγουμε ποιες στήλες θέλουμε να συσχετίσουμε.

3 Δημιουργία γραφικής παράστασης
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H δημιουργία γραφικής παράστασης συνάρτησης γίνεται μέσα από μια διαφορετική διαδικασία. Στη

συγκεκριμένη περίπτωση, δε χρειάζεται φύλλο δεδομένων, καθώς η διαδικασία αυτή δημιουργεί αυτόματα

το φύλλο δεδομένων και το μόνο που χρειάζεται είναι να δοθεί ο μαθηματικός τύπος της συνάρτησης που

είναι μια αριθμητική παράσταση του τύπου y=f(x), όπως είναι π.χ. y=3cos2(x) ή y=3x2+5x-2.

3 Δημιουργία γραφικής παράστασης

Για να δημιουργήσουμε τη γραφική παράσταση από μια

συνάρτηση επιλέγουμε File-New-Graph.

To Origin δημιουργεί ένα κενό γραφικό παράθυρο και στη

συνέχεια επιλέγουμε Graph-Add Function Graph που

εμφανίζει το επόμενο πλαίσιο διαλόγου, στο οποίο

επιλέγουμε τα διαφορετικά στοιχεία για τη συνάρτηση που

επιθυμούμε να σχεδιάσουμε.

Γραφική παράσταση συνάρτησης
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3 Δημιουργία γραφικής παράστασης
Γραφική παράσταση συνάρτησης
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4 Μορφοποίηση δεδομένων γραφικής παράστασης

Με διπλό click πάνω στον αριθμό του επιπέδου απεικόνισης (1, 2, 3,…) ανοίγει το πλαίσιο διαλόγου

που μας δείχνει τα περιεχόμενα του συγκεκριμένου επιπέδου απεικόνισης (Layer1), από όπου

μπορούμε να προσθέσουμε ή να αφαιρέσουμε καμπύλες στη συγκεκριμένη γραφική παράσταση,

καθώς το αριστερό μέρος μάς δείχνει όλα τα διαθέσιμα φύλλα δεδομένων που υπάρχουν στην

εργασία αυτή (project), ενώ το δεξιό μέρος τις καμπύλες που ήδη υπάρχουν στη συγκεκριμένη

γραφική παράσταση.
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4 Μορφοποίηση δεδομένων γραφικής παράστασης Αν επιλέξουμε Plot Setup εμφανίζεται το

πλαίσιο διαλόγου που περιλαμβάνει πιο

αναλυτικά τα περιεχόμενα της γραφικής

παράστασης.

Στο παράθυρο αυτό με δεξί-click πάνω

στο σετ δεδομένων στη λίστα στο κάτω

μέρος του παραθύρου μπορούμε και να

επιλέξουμε Remove και στη συνέχεια OK

ή Apply για να ενημερώσουμε τη

γραφική παράσταση για τη διαγραφή

της συγκεκριμένης καμπύλης.

Επίσης μπορώ να αλλάξω τη σειρά

εμφάνισης των καμπυλών στο γράφημα

και την αντίστοιχη λεζάντα (με drag &

drop).
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4 Μορφοποίηση δεδομένων γραφικής παράστασης Αν επιλέξουμε Plot Setup

εμφανίζεται το πλαίσιο διαλόγου

που περιλαμβάνει πιο αναλυτικά τα

περιεχόμενα της γραφικής

παράστασης.

Στο παράθυρο αυτό με δεξί-click

πάνω στο σετ δεδομένων στη λίστα

στο κάτω μέρος του παραθύρου

μπορούμε και να επιλέξουμε

Remove και στη συνέχεια OK ή

Apply για να ενημερώσουμε τη

γραφική παράσταση για τη

διαγραφή της συγκεκριμένης

καμπύλης.
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4 Μορφοποίηση δεδομένων γραφικής παράστασης

Έστω ότι έχουμε ένα

παράθυρο που απεικονίζει μια

σειρά καμπυλών σε μια ενιαία

γραφική παράσταση. Με διπλό

click πάνω σε οποιοδήποτε

σημείο μίας από τις καμπύλες

δεδομένων που απεικονίζονται

ανοίγει το παράθυρο διαλόγου

Plot Details > Plot Properties.

Μορφοποιώντας την απεικόνιση των δεδομένων
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4 Μορφοποίηση δεδομένων γραφικής παράστασης

Έστω ότι έχουμε ένα

παράθυρο που απεικονίζει μια

σειρά καμπυλών σε μια ενιαία

γραφική παράσταση. Με διπλό

click πάνω σε οποιοδήποτε

σημείο μίας από τις καμπύλες

δεδομένων που απεικονίζονται

ανοίγει το παράθυρο διαλόγου

Plot Details > Plot Properties.

Μορφοποιώντας την απεικόνιση των δεδομένων
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4 Μορφοποίηση δεδομένων γραφικής παράστασης

Γραμμές εργαλείων

Στο πρόγραμμα Origin υπάρχουν διάφορες γραμμές εργαλείων, όπως

στα περισσότερα παραθυρικά προγράμματα και μια εργαλειοθήκη

ανάλογη με εκείνη των περισσότερων προγραμμάτων γραφικών.

Η εμφάνιση/απόκρυψη των γραμμών εργαλείων γίνεται μέσα από το

μενού View > Tool bars και συγκεκριμένα επιλέγοντας ποιες γραμμές

εργαλείων θα είναι ενεργές.

Η εργαλειοθήκη που εμφανίζεται στο αριστερό μέρος του

προγράμματος είναι η γραμμή εργαλείων Tools που περιλαμβάνει τα

βασικά εργαλεία επιλογής δεδομένων γραφικής παράστασης και

προσθήκης αντικειμένων στο φόντο της γραφικής παράστασης.

Rescale, 
Επανεμφάνιση 

όλων των 
δεδομένων

Νew Legend,
Εμφάνιση/ 
ενημέρωση 

λεζάντας

Εμφάνιση αριθμητικών 
τιμών (x, y) γραφήματος 

σε τυχαίο σημείο, 
σε σημείο δεδομένων

Επιλογή δεδομένων για 
επεξεργασία

Εισαγωγή πλαισίου 
κειμένου

Εισαγωγή γραμμής 
ή σχήματος

Εισαγωγή εξίσωσης
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5 Μορφοποίηση στοιχείων γραφικής παράστασης

Διαμόρφωση αξόνων

Με διπλό click πάνω σε ένα από τους δύο

άξονες ανοίγει το ενιαίο πλαίσιο διαλόγου

των αξόνων που περιλαμβάνει τις επιλογές

Scale, Title & Format, Grid Lines, Break, Τick

Labels, Minor Tick Labels, Custom Tick

Labels.
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5 Μορφοποίηση στοιχείων γραφικής παράστασης

Διαμόρφωση αξόνων

Με διπλό click πάνω σε ένα από

τους δύο άξονες ανοίγει το ενιαίο

πλαίσιο διαλόγου των αξόνων που

περιλαμβάνει τις επιλογές Scale,

Title & Format, Grid Lines, Break,

Τick Labels, Minor Tick Labels,

Custom Tick Labels.
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5 Μορφοποίηση στοιχείων γραφικής παράστασης

Διαμόρφωση αξόνων

Με διπλό click πάνω σε ένα από τους δύο

άξονες ανοίγει το ενιαίο πλαίσιο

διαλόγου των αξόνων που περιλαμβάνει

τις επιλογές Scale, Title & Format, Grid

Lines, Break, Τick Labels, Minor Tick

Labels, Custom Tick Labels.
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5 Μορφοποίηση στοιχείων γραφικής παράστασης

Διαμόρφωση αξόνων

Με διπλό click πάνω σε ένα από τους δύο

άξονες ανοίγει το ενιαίο πλαίσιο

διαλόγου των αξόνων που περιλαμβάνει

τις επιλογές Scale, Title & Format, Grid

Lines, Break, Τick Labels, Minor Tick

Labels, Custom Tick Labels.
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5 Μορφοποίηση στοιχείων γραφικής παράστασης

Το υπόμνημα ή πλαίσιο λεζαντών είναι ένα γραφικό παράθυρο που εμφανίζεται πάνω σε μια γραφική

παράσταση και περιγράφει τις καμπύλες που φαίνονται στη γραφική παράσταση. Το υπόμνημα είναι

απαραίτητο για γραφικές παραστάσεις που περιέχουν παραπάνω από μία καμπύλες, ώστε να είναι

εμφανές ποια δεδομένα αντιστοιχούν σε ποια καμπύλη.
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6 Δημιουργώντας μια αναφορά Για να αποκτήσετε μια εκτύπωση της γραφικής παράστασης μπορείτε

να χρησιμοποιήσετε το πλαίσιο διαλόγου εκτύπωσης που είναι κοινό

σε όλες τις εφαρμογές των Windows. Απλά επιλέξτε File – Print για να

ανοίξει το αντίστοιχο πλαίσιο διαλόγου

Εκτύπωση γραφικών παραστάσεων

Οι επιλογές που έχετε είναι να

αλλάξετε το μέγεθος του χαρτιού,

ο προσανατολισμός εκτύπωσης

και άλλες επιλογές επιλέγοντας το

κουμπί Properties.

Αφού επιλέξετε τις κατάλληλες

επιλογές πατήστε <OK> και με ένα

δεύτερο <OK> μπορείτε να

εκτυπώσετε.
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1. Ενεργοποιήσετε το υπάρχον γράφημα στο οποίο θέλετε να προσθέσετε ένα ένθετο γράφημα.

2. Επιλέξτε Tools - Layer – Add για να δημιουργήσετε ένα δεύτερο επίπεδο στο υπάρχον γράφημα.

3. Επιλέξτε το νέο αυτό επίπεδο και μετακινήστε το στην πάνω αριστερή γωνία του αρχικού γραφήματος και

μικρύνετε το σε μέγεθος.

4. Με διπλό-click στον Χ-άξονα και βάλτε τις τιμές 70 και 80 ενώ στην αντίστοιχη επιλογή για τον Υ-άξονα 0.007 και

0.021. Μεγαλώστε το μέγεθος της γραμματοσειράς των ετικετών.

5. Ενεργοποιήστε το επίπεδο 1 και επαναλαμβάνοντας το βήμα 2 ώστε να δημιουργήσετε και ένα τρίτο επίπεδο το

οποίο τοποθετήστε στην κάτω δεξιά γωνία του αρχικού γραφήματος.
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6. Με διπλό-click στον Χ-άξονα και βάλτε τις τιμές 75.3 και 76.6 ενώ στην

αντίστοιχη επιλογή για τον Υ-άξονα 0.012 και 0.0271. Μεγαλώστε το μέγεθος

της γραμματοσειράς των ετικετών.

7. Με αριστερό click οπουδήποτε πάνω στο επίπεδο 1 επιλέξτε Plot Details Set -

line colors και για τα τρία επίπεδα.

8. Με την επιλογή Box Tool μπορείτε να προσθέσετε πλαίσια γύρω από τα επίπεδα

1 και 2

9. Προσθέστε βέλη ώστε να συνδέσετε τα ένθετα με τα πλαίσια.

6 Δημιουργώντας μια αναφορά

Σύνθετα γραφήματα: Ένθετο γράφημα σε υπάρχον γράφημα
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6 Δημιουργώντας μια αναφορά

Εμφανίζεται ένα πλαίσιο διαλόγου που σας ρωτάει αν επιθυμείτε να κρατήσετε και τις παλιές γραφικές

παραστάσεις (Επιλέξτε <Yes>). Στη συνέχεια εμφανίζονται οι επιλογές διευθέτησης των επίπεδων και του

διαχωρισμού των γραφικών.

Πολλαπλά επίπεδα γραφικών παραστάσεων 

Αρχικά δημιουργήστε τις 2 ή περισσότερες γραφικές.

Έχοντας όλες τις σχετικές γραφικές παραστάσεις ανοικτές και

επιλέγοντας μια από αυτές επιλέξτε Merge all Graph Windows

από το μενού Edit.

Αφήστε τις προκαθορισμένες επιλογές και επιλέξτε <OK>. Αν είχατε δημιουργήσει δύο γραφικές

παραστάσεις αυτές θα εμφανιστούν η μια κάτω από την άλλη όπως δείχνει και το παρακάτω σχήμα.

Από το μενού Edit και την επιλογή Add & Arrange Layers μπορείτε να μεταβάλλετε το κατακόρυφο

διάστημα μεταξύ των δύο γραφικών παραστάσεων.
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• Ας δοκιμάσουμε να εκτυπώσουμε περισσότερα του ενός γραφήματα στην ίδια σελίδα. Επιλέξτε File –

Νew και επιλέξτε Layout. 

• Ένα νέο παράθυρο εμφανίζεται με μια λευκή σελίδα. 

• Από την επιλογή Layout - Add Graph ή/και Layout - Add Worksheet για να προσθέσετε 

γραφήματα και πίνακες στην λευκή σελίδα ώστε να εκτυπωθούν.

• Μπορείτε να αλλάξετε το μέγεθος των γραφημάτων και των πινάκων και να τα ευθυγραμμίσετε 

χρησιμοποιώντας τη γραμμή εργαλείων αντικειμένων που φαίνεται παρακάτω. 

Αν δεν εμφανίζεται αυτή η γραμμή εργαλείων μπορείτε να την εμφανίσετε επιλέγοντας View - Toolbars

- Object Edit. Με βάση αυτές τις οδηγίες μπορείτε να δημιουργείστε μια σελίδα που να περιέχει το

γράφημα και τον αντίστοιχο πίνακα στην ίδια σελίδα.

Αναφορά διάταξης σχημάτων

6 Δημιουργώντας μια αναφορά
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6 Δημιουργώντας μια αναφορά

✓ Εκτός από τη δυνατότητα εκτύπωσης έχετε τη δυνατότητα να εξάγετε μια γραφική παράσταση σε μορφή

εικόνας, οπότε και να την χρησιμοποιήσετε ως αντικείμενο σε άλλα προγράμματα (π.χ. Word, Powerpoint,

Latex).

✓ Από το μενού File επιλέξτε την επιλογή Export Page επιλέγοντας το format εικόνας που επιθυμείτε από μια

μεγάλη σειρά επιλογών που περιλαμβάνει αρχεία εξόδου τύπου: AI, BMP, CGM, DXF, EMF, EPS, GIF, JPG, PCX,

PDF, PNG, PSD, TGA, TIF, WMF, XPM και XWD.

✓ Αποθηκεύστε το τελευταίο γράφημα μαζί με τον αντίστοιχο πίνακα που δημιουργήσατε σε μορφή tiff, wmf, jpg

και ελέγξτε το μέγεθος των αντίστοιχων αρχείων μέσα από την επιλογή: File - Export Page επιλέγοντας κάθε

φορά από το αντίστοιχο πλαίσιο διαλόγου τον αντίστοιχο τύπο (tiff, wmf, jpg) και αποθηκεύστε τα στον

προσωπικό σας χώρο Z:

✓ Για να εισάγετε τις εικόνες αυτές στο Word ανοίξτε το πρόγραμμα Word και από την επιλογή Insert Picture

from file εισάγετε τα τρία αυτά αρχεία σε ένα υπάρχον έγγραφο του Word.

Διασύνδεση του Origin με άλλα προγράμματα
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7 Παραδείγματα γραφημάτων στο Origin

1. Επιλέξτε μια στήλη που περιέχει τις πρωτογενείς πειραματικές μετρήσεις.

2. Από το μενού επιλογών επιλέγω: Plot→ Statistical Graphs→ Histogram

3. Δεξί-click στο παράθυρο γραφικών και επιλέξτε Plot Details από το μενού.

4. Επιλέξτε Curve Type→ Data→ Normal

5. Η καμπύλη που μόλις δημιουργήσατε είναι μια κανονική κατανομή και

στηρίζεται στη μέση τιμή και στην τυπική απόκλιση. Η καμπύλη

κανονικοποιείται στη μέγιστη τιμή του διαγράμματος.

6. Επιλογές Καμπυλών: Lognormal, Poisson, Exponential, Laplace, Lorentz

Ιστόγραμμα συχνοτήτων Το ιστόγραμμα είναι γραφική απεικόνιση στατιστικών συχνοτήτων περιοχών τιμών

ενός μεγέθους. Σχηματίζεται από παρακείμενα ορθογώνια. Η επιφάνεια κάθε

ορθογωνίου είναι μέτρο της συχνότητας εμφάνισης της συγκεκριμένης περιοχής

τιμών ενώ το ύψος του ισούται με το λόγο της συχνότητας προς το εύρος των τιμών

που αντιπροσωπεύει το ορθογώνιο

Στατιστικές πληροφορίες για τα δεδομένα, 
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Population by Major Ethnic Groups in Southern California
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2. Με δεξί-click στο διάγραμμα επιλέξτε Plot Details.

3. Στην επιλογή Pie Geometry βάλτε:

3D View Angle→15, Thickness→30, Rotation Starting Azimuth→125

Radius/Center Rescale Radius→ 5, Displacement→ 20

Explode Wedge→White

4. Στην επιλογή Labels, επιλέξτε Categories και Percentages. Μην επιλέγετε το

check box Associate with Wedge.

5. Στην επιλογή Pattern επιλέξτε Border color → Light Gray, Fill color to

Increment, starting from Wine.

6. Επιλέξτε το επίπεδο 1 και από την επιλογή Background βάλτε το χρώμα του

φόντου σε Dark Cyan.

7. Οι διάφορες ετικέτες μπορούν να μετακινηθούν και να μορφοποιηθούν

ανεξάρτητα. Στις λεπτές φέτες μπορείτε να βάλετε βέλη για μεγαλύτερη

ευκρίνεια.

7 Παραδείγματα γραφημάτων στο Origin

Πως μπορώ  να δημιουργήσω ένα γράφημα πίτας

1. Επιλέξτε τη στήλη B του φύλλου εργασίας και δημιουργήστε ένα διάγραμμα πίτας.
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1. Με κρατημένο το Ctrl-επιλέξτε τις στήλες A και C και δημιουργήστε ένα πολικό

διάγραμμα.

2. Με κρατημένο το ALT και διπλό-click στο επίπεδο 1 προσθέστε τα δεδομένα της

στήλης Β στο επίπεδο αυτό.

3. Με δεξί-click στο επίπεδο 1 επιλέξτε Layer Properties και Display και στη συνέχεια

επιλέξτε το check box 'Grid on Top of Data'. Επιλέξτε Apply.

4. Επιλέξτε τη σειρά δεδομένων C και αλλάξτε το Line color σε Dark Cyan και επιλέξτε

το check box 'Fill Area Under Curve' checkbox.

5. H επιλογή Pattern καθορίζει το χρώμα του γεμίσματος.
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7 Παραδείγματα γραφημάτων στο Origin

Πως θα δημιουργήσω ένα πολικό διάγραμμα; Στα μαθηματικά, το πολικό σύστημα

συντεταγμένων είναι ένα δισδιάστατο σύστημα συντεταγμένων

στο οποίο η θέση οποιουδήποτε σημείου σε ένα επίπεδο

καθορίζεται από την απόσταση του σημείου αυτού από ένα σημείο

αναφοράς και τη γωνία από μία επιλεγμένη κατεύθυνση.

Με διπλό click πάνω σε μία καμπύλη ανοίγει το παράθυρο Plot Setup (διαφάνεια 17) από όπου μπορώ να αλλάξω τη σειρά

εμφάνισης των «καμπυλών», άρα να εμφανίζεται η μικρότερης επιφάνειας καμπύλη εμπρός από την μεγαλύτερης επιφάνειας.



Data processing 
Input-Process-Output Ομάδα Β. Επεξεργασία πειραματικών δεδομένων

Εργασία Γραφικές αραστάσεις δύο διαστάσεων

|35Εργαστήριο Εφαρμοσμένης Πληροφορικής
Τμήμα Φυσικής-ΑΠΘ

82 84 86 88 90 92

1E-3

0,01

0,1

1

10

100
82 84 86 88 90 92

770

780

790

0

2

4

6

 As Grown

 Annealed

 T
C

L
e

ft
 Y

 A
x
is

 T
it
le

Bottom X Axis Title

 R
ig

h
t 
Y

 A
x
is

 T
it
le

 -
 L

a
y
e

r 
2

 Top X Axis Title

 R
ig

h
t 
Y

 A
x
is

 T
it
le

 -
 L

a
y
e

r 
3

1. Επιλέξτε δύο στήλες π.χ. Tc(X) και P(Y) για να δημιουργήσετε ένα

διάγραμμα scatter.

2. Με δεξί-click στο εικονίδιο του επιπέδου 1 στην πάνω αριστερή γωνία Layer

Properties Size/Speed Width (under Layer Area)→60.

3. Επιλέξτε από το μενού Edit→ New Layer(Axes):(Linked):Top X+Right Y.

4. Δεξί-click στο επίπεδο 2 και επιλέξτε Layer Contents, και προσθέστε μια νέα

σειρά δεδομένων data1_ta και τα αντίστοιχα σφάλματα: data1_err.

5. Επιλέξτε Layer Properties - Link Axes Scales - X Axis Link to Straight(1

to 1).
6. Διπλό-click στον X-axis και βλατε την κλίμακα από 82 ως 92 και την επιλογή Rescale στο Manual.

7. Επιλέξτε τον αριστερό Y axis και αλλάξτε τον τύπο το Log10. Βάλτε τα όρια: 1e-3 ως 100.

8. Διπλό-click στον δεξιό Y axis και βάλτε τα όρια 765 ως 795, με βήμα 10.

9. Επιλέξτε με δεξί-click εκτός των αξόνων add New Layer(Axes): (Linked):Right Y.

10. Επιλέξτε με δεξί-click το επίπεδο 3, και προσθέστε στο επίπεδο αυτό ένα σετ δεδομένων data1_dtc.

11. Επιλέξτε Layer Properties, και μετά Link Axes Scales και επιλέξτε Layer 1.

12. Στο πλαίσιο διαλόγου του άξονα στην επιλογή Title & Format tab, βάλτε Axis Position % From

Right και βάλτε την τιμή 20.

7 Παραδείγματα γραφημάτων στο Origin

Εμφανίζοντας διαφορετικούς άξονες στο ίδιο διάγραμμα 
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Σε όλα τα διαγράμματα να φαίνονται τα φυσικά μεγέθη σε κάθε άξονα και να τοποθετηθούν τίτλοι και λεζάντες. Η

τελική εργασία να παραδοθεί σε πρόγραμμα επεξεργασίας κειμένου όπου να φαίνονται τα σχήματα, τα ονόματα των

αντιστοίχων αρχείων καθώς και ένα μικρό κείμενο όπου αυτό κρίνεται σκόπιμο. Μαζί με το αρχείο επεξεργασίας

κειμένου να παραδώσετε και ένα αρχείο του Origin που να περιέχεις όλες τις γραφικές παραστάσεις.

7 Εργασία 5: Γραφικές παραστάσεις δεδομένων
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1. Να γίνουν οι παρακάτω γραφικές παραστάσεις  (α-δ)

Να προσδιορίσετε γραφικά τα τοπικά ακρότατα στα σχήματα α, β, γ και 

τα σημεία τομής των δύο καμπυλών στο σχήμα δ
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Σε όλα τα διαγράμματα να φαίνονται τα φυσικά μεγέθη σε κάθε άξονα και να τοποθετηθούν τίτλοι και λεζάντες. Η

τελική εργασία να παραδοθεί σε πρόγραμμα επεξεργασίας κειμένου όπου να φαίνονται τα σχήματα, τα ονόματα των

αντιστοίχων αρχείων καθώς και ένα μικρό κείμενο όπου αυτό κρίνεται σκόπιμο. Μαζί με το αρχείο επεξεργασίας

κειμένου να παραδώσετε και ένα αρχείο του Origin που να περιέχεις όλες τις γραφικές παραστάσεις.

7 Εργασία 5: Γραφικές παραστάσεις δεδομένων

2). Mε δεδομένα τα αρχεία dat22_5.txt, dat45.txt, dat90.txt να 

κατασκευάσετε το διάγραμμα (1 m=3.280 feet)
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Περιγράψτε τι δείχνει το διάγραμμα και πως επηρεάζονται τα

μεγέθη που απεικονίζονται όταν αλλάζει κάποια παράμετρος
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Σε όλα τα διαγράμματα να φαίνονται τα φυσικά μεγέθη σε κάθε άξονα και να τοποθετηθούν τίτλοι και λεζάντες. Η

τελική εργασία να παραδοθεί σε πρόγραμμα επεξεργασίας κειμένου όπου να φαίνονται τα σχήματα, τα ονόματα των

αντιστοίχων αρχείων καθώς και ένα μικρό κείμενο όπου αυτό κρίνεται σκόπιμο. Μαζί με το αρχείο επεξεργασίας

κειμένου να παραδώσετε και ένα αρχείο του Origin που να περιέχεις όλες τις γραφικές παραστάσεις.

7 Εργασία 5: Γραφικές παραστάσεις δεδομένων

Εμφανίζοντας διαφορετικούς άξονες στο ίδιο διάγραμμα 

3). Από το αρχείο Polar.dat να

δημιουργήσετε το παρακάτω γράφημα:
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4). Από το αρχείο Histdata.dat να δημιουργήσετε το

παρακάτω γράφημα:

40 60 80 100 120 140 160
0

200

400

600

800

1000

 

 

Περιοχές Μετρήσεων



Data processing 
Input-Process-Output Ομάδα Β. Επεξεργασία πειραματικών δεδομένων

Εργασία Γραφικές αραστάσεις δύο διαστάσεων

|39Εργαστήριο Εφαρμοσμένης Πληροφορικής
Τμήμα Φυσικής-ΑΠΘ

Σε όλα τα διαγράμματα να φαίνονται τα φυσικά μεγέθη σε κάθε άξονα και να τοποθετηθούν τίτλοι και λεζάντες. Η

τελική εργασία να παραδοθεί σε πρόγραμμα επεξεργασίας κειμένου όπου να φαίνονται τα σχήματα, τα ονόματα των

αντιστοίχων αρχείων καθώς και ένα μικρό κείμενο όπου αυτό κρίνεται σκόπιμο. Μαζί με το αρχείο επεξεργασίας

κειμένου να παραδώσετε και ένα αρχείο του Origin που να περιέχεις όλες τις γραφικές παραστάσεις.

7 Εργασία 5: Γραφικές παραστάσεις δεδομένων

Εμφανίζοντας διαφορετικούς άξονες στο ίδιο διάγραμμα 

5). Να δημιουργήσετε διαγράμματα πίτας για τα περιστατικά Covid-19 που δίνονται στον παρακάτω πίνακα
(πηγή (11/2021)

Περιοχή Κρούσματα Θάνατοι 

 

United States 48,092,052 775,403 

 

European Union 45,201,793 835,548 

 

India 34,544,882 466,980 

 

Brazil 22,043,112 613,339 

 

United Kingdom 10,028,829 144,728 

 

Russia 9,270,885 262,733 

 

Turkey 8,654,142 75,618 

 

https://en.wikipedia.org/wiki/Template:COVID-19_pandemic_data
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Σε όλα τα διαγράμματα να φαίνονται τα φυσικά μεγέθη σε κάθε άξονα και να τοποθετηθούν τίτλοι και

λεζάντες. Η τελική εργασία να παραδοθεί σε πρόγραμμα επεξεργασίας κειμένου όπου να φαίνονται τα

σχήματα, τα ονόματα των αντιστοίχων αρχείων καθώς και ένα μικρό κείμενο όπου αυτό κρίνεται

σκόπιμο. Μαζί με το αρχείο επεξεργασίας κειμένου να παραδώσετε και ένα αρχείο του Origin που να

περιέχεις όλες τις γραφικές παραστάσεις.

7 Εργασία 5: Γραφικές παραστάσεις δεδομένων

Εμφανίζοντας διαφορετικούς άξονες στο ίδιο διάγραμμα 

6). Από τις μετρήσεις μιας ωμικής (R=V/I) αντίστασης με βολτόμετρο και αμπερόμετρο κατασκευάστηκε ο

παρακάτω πίνακας. Οι πειραματικές μετρήσεις έντασης, τάσης θεωρείστε ότι έχουν σφάλμα 10% επί της

πειραματικής τιμής. Στο περιβάλλον του προγράμματος Origin:

α). Δημιουργήστε ένα νέο φύλλο εργασίας

β). Εισάγετε τα δεδομένα Ι, V μαζί με τα αντίστοιχα σφάλματα και δημιουργήστε το αντίστοιχο γράφημα V-I.

γ). Υπολογίστε την αντίσταση σε Ohm (R=V/I) και την ισχύ σε Watt (P=IV). Ta σφάλματα σε αυτή την

περίπτωση είναι 15% για την ισχύ και την αντίσταση. Δημιουργήστε το γράφημα P-R.

I (mA) V(V)

0.3 1
0.7 4
1.1 6
1.5 8
1.9 10
2.3 12
2.7 14
3.1 15
3.5 19
3.9 20
4.3 21
4.7 26
5.1 29
5.5 27
5.9 31
6.3 38
6.7 33
7.1 46
7.5 38
8.0 42
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